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1. Using the Scanner Function
This chapter explains how to use the scanner functions.

Network Settings
Make the following network settings according to the network interface you are using.

The following table shows the settings that can be specified and their default factory values.

Setting Name Value

Effct. Protocol IPv4: Active

IPv6: Inactive

Ethernet Speed Auto Select

Machine IPv4 Address Auto-Obtain (DHCP)

IPv4 Gateway Address 0.0.0.0

Machine IPv6 Address -

IPv6 Gateway Address -

IPv6 Stateless Setting Active

Domain Name Auto-Obtain (DHCP)

DNS Configuration Auto-Obtain (DHCP)

DDNS Configuration Active

Permit SNMPv3 Communictn. Encryption/Cleartext

Permit SSL/TLS Comm. Ciphertext Priority

Auto Email Notify Inactive

The following example explains how to allocate an IPv4 address.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Interface Settings], and then press the [OK] key.
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6. Press the [ ] or [ ] key to display [Network], and then press the [OK] key.

7. Press the [ ] or [ ] key to display [Machine IPv4 Address], and then press the [OK] key.

8. Press the [ ] or [ ] key to display [Specify], and then press [IP Add.].

The current IP address appears on the display.

9. Press the number keys to specify values in each field, and then press the [OK] key.

To get an IP address for the machine, contact your network administrator.

10. Specify "Subnet Mask" in the same way.

11. After you have made all the settings, press the [OK] key.

The specified settings are set and the initial screen reappears.

You can print the configuration page to confirm the specified settings.

1. Using the Scanner Function
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Scanning Using the Control Panel
Scanning using the control panel allows you to send scanned files via e-mail (Scan to E-mail), to an FTP
server (Scan to FTP), or to the shared folder of a computer on a network (Scan to Folder), or to a USB
flash drive (Scan to USB).

The Scan to E-mail, Scan to FTP, and Scan to Folder functions are available only through a network
connection. No network connection is required for the Scan to USB function; you can send scanned files
directly to a USB flash drive inserted into the front of the machine.

Registering Folders

By registering a shared folder, you can send scan files to it directly.

There are two protocols you can use:

• SMB: For sending files to shared Windows folders.

• FTP: For sending files to an FTP server.

Register an SMB folder

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Address Book Management], and then press the [OK]
key.

7. Press the [ ] or [ ] key to display [Program/Change], and then press the [OK] key.

8. Enter the registration number you want to program using the number keys, and then
press the [OK] key.

You can automatically specify registration numbers 001- 020 by pressing the Quick Dial keys.

Press [Search] to search by name, display destination list, registration No., fax destination, e-mail
address, or folder name.

9. Enter the name and then press the [OK] key.

You can enter a name of up to 20 characters.

10. Press [Dest.].

11. Press the [ ] or [ ] key to display [Auth. Info], and then press the [OK] key.

12. Press the [ ] or [ ] key to display [Folder Authentication], and then press the [OK] key.

Scanning Using the Control Panel
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13. Press the [ ] or [ ] key to display [Specify Other Auth. Info], and then press [User].

When [Do not Specify] is selected, the [SMB User Name] and [SMB Password] that you have
specified in "Default User Name/PW(Send)" of [File Transfer] settings applies.

14. Enter the login user name, and then press the [OK] key.

15. Press [Password].

16. Enter the password, and then press the [OK] key.

17. Enter the password again to confirm, and then press the [OK] key.

18. Press the [OK] key.

19. Press the [Escape] key.

20. Press the [ ] or [ ] key to display [Folder Info], and then press the [OK] key.

21. Press the [ ] or [ ] key to display [SMB], and then press the [OK] key.

22. Press [Manual Entry] or [Browse Network] to specify the path entry method using [ ] or
[ ], and then press the [OK] key.

To specify a folder, you can either enter the path manually or locate the folder by browsing the
network. For details, see p.6 "To locate the folder manually" and p.6 "To locate the folder
using Browse Network".

23. Press [Com.Test] to check the path is set correctly.

If the connection test fails, check the settings, and then try again.

24. Press [Exit].

25. Press the [Escape] key.

26. Press [Exit].

27. Press the [OK] key.

To locate the folder manually

1. Press the [ ] or [ ] key to display [Manual Entry], and then press the [OK] key.

2. Enter the path and then press the [OK] key.

For example: if the name of the destination computer is "User", and the folder name is "Share", the
path will be \\User\Share.

If the format of the entered path is not correct, a message appears. Press [Exit], and then enter the
path again.

To locate the folder using Browse Network

1. Press the [ ] or [ ] key to display [Browse Network], and then press the [OK] key.

The client computers sharing the same network as the machine appear.

1. Using the Scanner Function
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Network display only lists client computers you are authorized to access.

2. Select a work group using the scroll keys, and then press the [OK] key.

3. Select a client computer using the scroll keys, and then press the [OK] key.

Shared folders under it appear.

You can press [Up] to switch between levels.

4. Select the folder you want to register using the scroll keys, and then press [Apply].

5. Press the [OK] key.

Registering an FTP folder

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Address Book Management], and then press the [OK]
key.

7. Press the [ ] or [ ] key to display [Program/Change], and then press the [OK] key.

8. Enter the registration number you want to program using the number keys, and then
press the [OK] key.

You can automatically specify registration numbers 001-020 by pressing the Quick Dial keys.

Press [Search] to search by name, display destination list, registration No., fax destination, e-mail
address, or folder name.

9. Enter the name, and then press the [OK] key.

You can enter a name of up to 20 characters.

10. Press [Dest.].

11. Press the [ ] or [ ] key to display [Folder Info], and then press the [OK] key.

12. Press the [ ] or [ ] key to display [FTP], and then press the [OK] key.

13. Enter the server name, and then press the [OK] key.

14. If you want to change the port number, enter the new port number, and then press the
[OK] key.

You can enter 1 to 65535.

15. If you want to change the path, enter the new path, and then press the [OK] key.

You can enter an absolute path, using this format: "/user/ home/username"; or a relative path,
using this format: directory/sub-directory".

Scanning Using the Control Panel
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You can enter a path using up to 128 characters.

If you leave the path blank, the login directory is assumed to be the current working directory.

You can also enter an IPv4 address.

16. Press [Com.Test] to check the path is set correctly.

If the connection test fails, check the settings, and then try again.

17. Press [Exit].

18. Press the [Escape] key.

19. Press the [ ] or [ ] key to display [Auth. Info], and then press the [OK] key.

20. Press the [ ] or [ ] key to display [Folder Authentication], and then press the [OK] key.

21. Press the [ ] or [ ] key to display [Specify Other Auth. Info], and then press [User].

When [Do not Specify] is selected, the [FTP User Name] and [FTP Password] that you have
specified in "Default User Name/PW(Send)" of [File Transfer] settings applies.

22. Enter the login user name, and then press the [OK] key.

23. Press [Password].

24. Enter the password, and then press the [OK] key.

25. Enter the password again to confirm, and then press the [OK] key.

26. Press the [OK] key.

27. Press the [Escape] key.

28. Press [Exit].

29. Press the [OK] key.

E-mail Destination

Register e-mail destinations so you do not need to enter an e-mail address every time, and can send
scan files from scanner or fax function by e-mail.

• You can use the e-mail address as the sender's address when sending scan files in scanner mode.

Registering an e-mail address

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

1. Using the Scanner Function
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6. Press the [ ] or [ ] key to display [Address Book Management], and then press the [OK]
key.

7. Press the [ ] or [ ] key to display [Program/Change], and then press the [OK] key.

8. Enter the registration number you want to program using the number keys, and then
press the [OK] key.

You can automatically specify registration numbers 001-020 by pressing the Quick Dial keys.

Press [Search] to search by name, display destination list, registration No., fax destination, e-mail
address, or folder name.

9. Enter the name, and then press the [OK] key.

You can enter a name of up to 20 characters.

10. Press [Dest.].

11. Press the [ ] or [ ] key to display [Email Settings], and then press the [OK] key.

You can enter an e-mail address of up to 64 characters.

12. Enter the e-mail address using the number keys, and then press the [OK] key.

13. Press the [ ] or [ ] key to display [Email/Internet Fax Dest.] or [Internet Fax Dest. Only],
and then press the [OK] key.

14. Press [Exit].

15. Press the [OK] key.

Basic Operation for Scan to E-mail/FTP/Folder

This section describes the basic operation for sending scanned files via e-mail, to an FTP server, or to a
computer, depending on the specified destination.

1. Press the [Scanner] key.

CHV061

Confirm that "Set original, specify dest." is shown on the screen.

2. Place the original on the exposure glass or in the ADF.

Scanning Using the Control Panel
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3. Press the [Address Book] key.

CHV062

4. Search for the desired destination by pressing the [ ] or [ ] key to scroll the address
book, and then press the [OK] key.

5. Press the [B&W Start] or [Color Start] key.

• To cancel scanning, press the [Clear/Stop] key.

• When using the exposure glass, place the next original on the exposure glass, and then press
the [B&W Start] or [Color Start] key. Repeat this step until all originals are scanned.

When all originals have been scanned, press [#] to start sending the scanned file.

Basic Operation for Scan to USB (SG 3110SFNw only)

This section describes the basic operation for sending scanned files to a USB flash drive.

• Keep USB flash memory devices out of reach of children. If a child accidentally swallows a USB
flash memory device, consult a doctor immediately.

• This machine does not support the use of USB flash drives connected to external USB hubs. Insert
your USB flash drive directly into the USB flash drive port located at the top left corner of the
machine.

• Certain types of USB flash drives cannot be used.

1. Using the Scanner Function
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1. Insert your USB flash drive into the USB flash drive port.

CHV086

The message "Save Scn Data to USB" appears on the display.

2. Press the [Scanner] key.

3. Place the original on the exposure glass or in the ADF.

4. Press the [B&W Start] or [Color Start] key.

• To cancel scanning, press the [Clear/Stop] key.

• When using the exposure glass, place the next original on the exposure glass, and then press
the [B&W Start] or [Color Start] key. Repeat this step until all originals are scanned.

When all originals have been scanned, press [#] to start sending the scanned file.

5. Confirm that "Sending..." appears on the display.

The scanned file is created in the root directory of the USB flash drive.

6. Remove the USB flash drive from the machine.

Scanning Using the Control Panel
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Scanning from a Computer
Scanning from a computer (TWAIN scanning) allows you to operate the machine from your computer
and scan originals into your computer directly.

TWAIN scanning is available with both USB and network connections.

The machine supports WIA scanning, an additional method of scanning originals from your computer.
WIA scanning is possible if your computer is running a WIA compatible application. For more
information, see the manual for your application.

Scanning from a Computer

The following procedure uses Windows 7 and Presto! PageManager as an example.

The procedure may vary depending on Presto! PageManager's version. For details, see the manual for
Presto! PageManager.

1. Place the original on the exposure glass or in the ADF.

2. On the [Start] menu, point to [All Programs], point to [Presto! PageManager X.XX], and
then click [Presto! PageManager X.XX].

"X.XX" indicates the version of Presto! PageManager.

3. On the [File] menu, click [Select Source...].

4. In the [Select Source] dialog box, select the scanner, and then click [OK].

5. On the [Tools] menu, click [Scan Central Settings...].

6. Configure the scan settings as required, and then click [OK].

For details, see the manual for Presto! PageManager.

7. On the [File] menu, click [Acquire Image Data...].

8. In [Original Scan Method:], select [Exposure Glass] (when using the exposure glass) or
[ADF] (when using the ADF).

9. Click [Scan].

10. On the [File] menu, click [Exit].

1. Using the Scanner Function
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2. Using the Fax Function (SG
3110SFNw only)
This chapter explains how to use the fax functions.

Connecting to a Telephone Line
You can connect the machine to the public switched telephone network (PSTN) directly or through a
private branch exchange (PBX).

Also, you can connect an external telephone to use the same telephone line for voice calls.

(mainly North America)

• To reduce the risk of fire, use only No. 26 AWG or larger telecommunication line cord.

(mainly North America)

• Pour réduire le risque d'incendie, utiliser uniquement des conducteurs de télécommunications 26
AWG ou de section supérieure.

• Make sure the connector is the correct type before you start.

• (mainly North America): By law in the United States, you must program your phone
number identification (your fax number) into your machine before you can connect to the public
phone system.

1. Open the ADF cover.

2. Remove the cable cover.

3. Connect a telephone line cord to LINE.

CHV110
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4. If using an external telephone, connect the telephone to TEL.

CHV111

5. Pass the telephone line cord through the opening in the cable cover.

6. Attach the cable cover in place.

7. Close the ADF cover, pressing it down firmly until it clicks.

2. Using the Fax Function (SG 3110SFNw only)
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Initial Setup
When you turn on the machine for the first time, a menu for configuring the settings described below will
appear on the display. This section describes how to complete the Initial Setup.

• Be sure to select the country of use. Selecting the wrong country may cause a fax transmission
failure.

• (mainly North America): The fax number code is required by international law. You
cannot legally connect a fax machine to the telephone system if the fax number code is not
programmed. Also, the fax header code and the date and time of transmission must be included in
the header of all pages faxed to, from, or within the United States.

Display language

The language selected here is used for the display.

1. Press the [User Tools] key.

2. Press the [ ] or [ ] key to display [Language], and then press the [OK] key.

3. Press the [ ] or [ ] key to select the desired language, and then press the [OK] key.

User fax number

The number entered here is used as the fax number of the machine. Numbers, space, and "+" can
be used for a user fax number.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [General Settings/Adjust], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Program Fax Information], and then press the [OK] key.

7. Press the [ ] or [ ] key to display [Own Fax Number], and then press the [OK] key.

8. Enter the user fax number (up to 20 characters), and then press the [OK] key.

User name

The name entered here is used as the fax sender name.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [General Settings/Adjust], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Program Fax Information], and then press the [OK] key.

Initial Setup
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7. Press the [ ] or [ ] key to display [Fax Header], and then press the [OK] key.

8. Enter the user name (up to 32 characters), and then press the [OK] key.

Country settings

The country selected here is used for configuring the language and measurement unit display
formats.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Country Setting], and then press the [OK] key.

6. Press the [ ] or [ ] key to select a country you want to specify, and then press the [OK] key.

Date and time

The time and date entered here are used for the machine’s internal clock.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Timer Settings], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Set Date], and then press the [OK] key.

7. Specify the date, and then press the [OK] key.

8. Press the [ ] or [ ] key to display [Set Time], and then press the [OK] key.

9. Specify the time, and then press the [OK] key.

Set Time zone

You can set the machine's time zone to between UTC-12:00 and UTC+13:00.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Set Time Zone], and then press the [OK] key.

7. Specify the time.

8. Press [+]or [-] to set the time zone, and then press the [OK] key.

2. Using the Fax Function (SG 3110SFNw only)
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Configuring Telephone Network Settings

Selecting the Telephone Line Type

Select the telephone line type according to your telephone line service. There are two types: tone and
pulse dial.

This function is not available in some regions.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Select Dial/Push Phone], and then press the [OK] key.

7. Press the [ ] or [ ] key to select the telephone line type appropriate for your telephone
service, and then press the [OK] key.

Selecting the Telephone Network Connection Type

Select the type of connection to the telephone network.

There are two types: public switched telephone network (PSTN) and private branch exchange (PBX).
When your machine is connected through a PBX, set to [Extension]. If it is connected directly to the
telephone network (PSTN), set to [Outside].

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [G3 Analog Line], and then press the [OK] key.

7. Press the [ ] or [ ] key to display [Extension/Outside], and then press the [OK] key.

8. Press the [ ] or [ ] key to display [Extension] or [Outside], and then press the [OK] key.

Configuring Telephone Network Settings
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Setting the Outside Line Access Number

If the machine is connected to the telephone network through a PBX, set the dial number to access the
outside line.

• Make sure to set the outside line access number that matches the setting of your PBX. Otherwise,
you may not be able to send faxes to outside destinations.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [G3 Analog Line], and then press the [OK] key.

7. Press the [ ] or [ ] key to display [Outside Access No.], and then press the [OK] key.

8. Enter the outside line access number using the number keys, and then press the [OK] key.

2. Using the Fax Function (SG 3110SFNw only)
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Sending a Fax
This section describes the transmission modes and the basic operations for sending a fax.

• It is recommended that you inform the receiver when you send a fax before sending important
documents.

Basic Operation for Sending a Fax

This section describes the basic operation for sending a fax.

1. Press the [Facsimile] key.

2. Place the original on the exposure glass or in the ADF.

3. Enter the fax number (up to 50 characters) using the number keys, or specify a desired
destination using the [Quick Dial] keys or [Address Book] key.

• A fax number can contain 0 to 9, pause, " ", and " ".

For details about specifying the fax destination, see p.21 "Specifying the Fax Destination".

• If the machine is connected to the telephone network through a PBX, make sure to enter the
outside line access number specified in [Outside Access No.] before the fax number. For
details about [Outside Access No.], see p.18 "Setting the Outside Line Access Number".

4. Press the [B&W Start] key.

CHV066

• The machine prompts you to enter the fax number twice only when you dial the destination
manually. If the fax numbers do not match, go back to step 3.

• When using the exposure glass, place the next original on the exposure glass, and then press
the [B&W Start] key. Repeat this step until all originals are scanned.

When all originals have been scanned, press [#] to start sending the fax.

Sending a Fax
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Fax Destination

Register a fax destination so you do not need to enter fax numbers each time, and can send documents
that have been scanned in using the fax function.

• Registered Fax numbers can be used as sender's Fax numbers.

You can program the following items in a fax destination:

Fax number

Registers the destination's fax number. You can enter a fax number using up to 50 digits. You must
include every digit in the number.

SUB code

Registering a SUB code allows you to use Confidential Transmission to send messages to the other
fax machines which support a similar function called "SUB Code".

SEP code

Registering a SEP code allows you to use Polling Reception to receive faxes from the other fax
machines which support Polling Reception, or Information Boxes.

Registering a fax number

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [System Settings], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Administrator Tools], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Address Book Management], and then press the [OK]
key.

7. Press the [ ] or [ ] key to display [Program/Change], and then press the [OK] key.

8. Enter the registration number you want to program using the number keys, and then
press the [OK] key.

You can automatically specify registration numbers 001-020 by pressing the Quick Dial keys.

Press [Search] to search by name, display destination list, registration No., fax destination, e-mail
address, or folder name.

9. Enter the name and then press the [OK] key.

You can enter a name of up to 20 characters.

10. Press [Dest.].

11. Press the [ ] or [ ] key to display [Fax Settings], and then press the [OK] key.

12. Enter the fax number using the number keys.

2. Using the Fax Function (SG 3110SFNw only)
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13. Press [Options] to specify optional settings such as "SUB Code", and "SEP Code".

14. Press [Exit].

15. Press the [OK] key.

16. Press [Exit].

17. Press the [OK] key.

Specifying the Fax Destination

This section explains how to specify a destination when sending a fax.

In addition to entering a destination using the number keys, you can specify a destination using:

• Quick Dial keys

• [Address Book] key

Specifying a destination using the Quick Dial keys

This section explains how to select a destination registered as a Quick Dial entry using the Quick Dial
keys. For details about registering a Quick Dial entry, see p.20 "Registering a fax number".

1. Press the [Facsimile] key.

2. Press the [Quick Dial] key to which the desired Quick Dial entry is registered.

If you want to use Quick Dial entries Nos. 11 to 20, press the [Shift] key before the [Quick Dial]
key.

CHV063

Specifying the destination using the [Address Book] key

This section explains how to select a destination registered in the machine's address book. For details
about registering fax numbers, see p.20 "Registering a fax number".

1. Press the [Facsimile] key.

Sending a Fax
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2. Press the [Address Book] key.

3. Press the [ ] or [ ] key to select the searching method, and then press the [OK] key.

• Search by name: [Search by Name]

Enter part of the name using the number keys.

• Search by destination list: [Display List]

Registered destinations are displayed in order.

• Search by registration number: [Search by Registration No.]

Enter the three-digit registration number using the number keys. The registered name appears.

• Search by fax number: [Search Fax Destination]

Enter the fax number you want to search for. The registered name appears.

4. Select the destination you want.

5. Press the [OK] key.

2. Using the Fax Function (SG 3110SFNw only)
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Receiving a Fax
This section describes fax reception functions.

• When receiving an important fax, we recommend you confirm the contents of the received fax with
the sender.

Selecting Reception Mode

There are two ways you can set up the machine to handle incoming calls.

• Manual Reception mode (an external telephone required)

• Auto Reception mode

Manual reception mode

When a telephone call comes in, the external telephone rings. If the call is a fax document, you
must switch manually to facsimile mode.

Auto reception mode

When a telephone call comes in, the machine automatically receives it as a fax document. Use this
setting on a dedicated fax line.

1. Press the [User Tools] key.

2. Press [Login].

3. Enter the login password, and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Fax Features], and then press the [OK] key.

5. Press the [ ] or [ ] key to display [Reception Settings], and then press the [OK] key.

6. Press the [ ] or [ ] key to display [Switch Reception Mode], and then press the [OK] key.

7. Press the [ ] or [ ] key to display [Manual Reception] or [Auto Reception], and then
press the [OK] key.

Manual reception

This section describes the basic operation for receiving a fax when the reception mode is set to [Manual
Reception] mode.

1. Pick up the handset of the external telephone to answer the call.

A normal telephone call starts.

2. When you hear a fax calling tone, press the [Facsimile] key, and then press the [B&W
Start] key.

Receiving a Fax
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3. Replace the handset.

Auto reception

When the reception mode is set to [Auto Reception] mode, the machine receives a fax automatically if
the incoming call is a fax call and the external telephone rings when it receives voice calls.

To start a normal telephone call, pick up the handset, press the [Facsimile] key, and then press the
[Clear/Stop] key. If you hear a fax calling tone, receive the fax manually. For details about manually
receiving a fax, see p.23 "Manual reception".

Trademarks

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

The proper names of the Windows operating systems are as follows:

• The product names of Windows 7 are as follows:

Microsoft® Windows® 7 Home Premium

Microsoft® Windows® 7 Professional

Microsoft® Windows® 7 Ultimate

Microsoft® Windows® 7 Enterprise

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
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